
Glossary
32-bit
An application specifically designed for a 32-bit computer running the Microsoft Windows 95 or later or Windows 
NT operating system. (An application that can work with 32 bits of information at a time.)
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About Microsoft Visual Basic
The Help menu command that displays online assistance, copyright information, and version number 
information.

Abs
A function that returns the absolute value of n.

access key
The letter the user can press to execute the command when the menu is open.

Add Form
Part of the Visual Basic toolbar, which you use to add forms to your programs.

Add Project
The File menu command that you use to load additional projects into Visual Basic. When you use this command,
outlining symbols that can help you organize and switch between projects appear in the Project window.

Add Watch
A command on the Debug menu, with which you add variables to the Watch window.

adding files
Adding individual files to a project by using commands on the Project menu. The changes that you make will be 
reflected immediately in the Project window.

adding projects
Loading additional projects into Visual Basic with the File menu Add Project command.

advanced operators 
Symbols used in special-purpose mathematical formulas and text processing applications. Visual Basic uses 
these advanced operators:

Mathematical Operation Symbol
Integer (whole number) division /
Remainder division Mod
Exponentiation (raising to a power) ^
String concatenation (combination) &

algorithm
An ordered list of programming steps that you use to guide your programming efforts.

argument
A value or an expression used with an operator or passed to a subprogram (subroutine, procedure, or function). 
The program then carries out operations using the argument(s).

arithmetic operators
Symbols used to perform arithmetic (numeric) functions-addition, subtraction, multiplication, and division. In 
Visual Basic, arithmetic operators include:

Mathematical operation Symbol
Addition +
Subtraction -



Multiplication *
Division /

assignment operator
An operator used to assign a value to a variable.

Atn
A function that returns the arctangent, in radians, of n.

Automation
A technology that allows one application to use the features of another application to do meaningful work.
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.BAS file
The filename extension of Visual Basic standard module files.

Biblio.mdb
A sample database included with Visual Basic for demonstration purposes. Biblio.mdb contains a current 
bibliography of books about database programming and related topics.

Boolean data
In Visual Basic, a data type that uses two bytes per variable and that returns a value of True or False.

BorderColor
A property that sets the line color to any Visual Basic standard color.

BorderStyle
A property that makes a line solid, dotted, or dashed.

BorderWidth
A property that adjusts the thickness of the line on your form. This is especially useful when you are creating an 
underline, or a line that separates one object from another.

bound control
A toolbox control that has been linked to a data object with the DataSource property.

bound object
An object is bound to a database when its DataSource property is set to a valid database name and its 
DataField property is set to a valid table in the database. After an object is bound to a database, it displays 
database information automatically. 

break mode
A condition during which you interrupt execution at a given spot in your program. Break mode gives you a close-
up look at your program while the Visual Basic compiler runs it.

Break
A command on the Run menu that temporarily halts the execution of a program and puts the compiler in break 
mode for debugging. 

by reference
A variable passed by reference can be modified by a procedure and returned to the program.

by value
A variable or literal value (such as a string in quotation marks) passed to a procedure that cannot be modified by 
the procedure. You can pass a variable by value if you enclose it in parentheses.

byte
In Visual Basic, a data type that requires 1 byte per variable and that returns values from 0 through 256.
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Caption
The Visual Basic property that sets the object description that the user will see.



Case Else
Part of the Select Case structure that displays a message if none of the earlier cases returns a value of True.

check box
A control that displays a list of choices and gives the user the option to pick multiple items (or none at all) from 
the list.

child form
In the hierarchy of Visual Basic forms, a form opened or initiated by another (parent) form.

Classes list box
The part of the Object Browser that lists types of Windows-based application objects.

Clear All Breakpoints
A command on the Debug menu that removes all debugging breakpoints from your application.

Close
When added to program code, this keyword closes the specified Visual Basic object.

Code window
A special text editing window designed specifically for Visual Basic program code. You can display the Code 
window in either of two ways:
® By clicking the View Code button in the Project window.
® By clicking the View Menu Code command. 

Color dialog box
One of the five standard dialog boxes created by the Common Dialog object. The color dialog box provides user-
defined color selection from a palette.

color palette
Part of the Visual Basic development environment, with which you choose colors for lines, shapes, and graphics 
effects.

combo box
A data input object created with the ComboBox control. Data items can be added to, removed from, or sorted in 
a combo box while your program runs.

CommonDialog
A Visual Basic control that creates one of five standard dialog boxes in your programs.

comparison operator
A symbol or other character that is part of an expression that compares two or more variables, conditions, or 
values.

conditional expression
Part of a complete program statement that asks a True-False question about a property, variable, or other bit of 
data in program code.

conditional test
A true or false question in an If...Then or Select...Case decision structure.

Connect
A property that links your program to other applications. Set the Connect property for the application you want to 
connect to.

constant
A variable, the value of which doesn't change while your program runs.

controls
Visual Basic tools, with which you add, format, and arrange elements of your program user interface.

Controls collection
In Visual Basic terminology, the entire set of objects on a form.

Cos
A function that returns the cosine of the angle n. The angle n is expressed in radians.



counter variable
A variable that keeps a running total of the number of times a loop is repeated. By convention, counter variables 
are indicated by the letter i, and the first value is usually 1.

cross
One of the 16 standard Windows mouse pointer styles. 

currency
A Visual Basic data type, which uses 8 bytes to store each variable and which returns values that range from -
922,337,203,685,477.5808 through 922,337,203,685,477.5807.

current location
In Visual Basic animation, the spot on the Form window (as indicated by the x, y coordinate system) at which a 
selected object is located.

custom counter
In a loop, variable with a counter pattern other than 1, 2, 3, 4, and so on.
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data field
The property you set to the name of the database field you want to display.

data object
An object you create with the data control to search for, add, sort, or delete database information.

data source
A property you use to a data object to create a bound control.

data types
A particular classification of data in a program. In Visual Basic, you can declare variables with specific data types
by using a type declaration character. Data types used in Visual Basic include:
® Byte
® Integer
® Long 
® Single-precision
® Double-precision
® Currency
® String
® Boolean
® Date
® Variant

database
An organized collection of information stored electronically in a file. Microsoft Visual Basic supports a number of 
popular database formats, including Microsoft Access, Microsoft FoxPro, Btrieve, Paradox, and dBASE. You can 
also use Open Database Connectivity (ODBC) client-server databases such as Microsoft SQL Server.

database engine
An underlying technology that controls information access in a database. The database engine in Visual Basic is
Microsoft Jet.

database formats
These include Microsoft Access, dBASE, Paradox, FoxPro, and several spreadsheet formats.

DatabaseName
A Visual Basic property used to create data objects. For example, setting the DatabaseName property to 
Pathname types the pathname of the database you want to open.

Debug toolbar
A Visual Basic debugging tool, which provides tools devoted entirely to tracking down program code errors.



debugging a program
The process of finding and correcting program code errors.

decision structure
A special block of statements that use conditional expressions. Visual Basic uses these types of decision 
structures: If...Then and Select Case.

declaring a variable
The process of creating a variable in your Visual Basic program code. You can declare variables explicitly with 
the Dim keyword or implicitly by typing a new variable name in a program statement.

declaring data types
The process of specifying the data types you use in your Visual Basic program code. You can specify some 
fundamental data types by adding a type-declaration character to the variable name.

design mode (design time)
The part of the software development cycle you spend designing your program

destination path
A variable, which specifies the pathname of a file you want to create.

Dim statement 
A program statement with which you declare (dimension) a variable explicitly. You make an explicit declaration 
by typing a Dim statement and the variable name.

Do loops
Program code that executes a group of statements repeatedly until a specified condition is met (until the variable
returns a value of True).

docking windows
Aligning and attaching windows to make all the elements of the programming system visible and accessible. 

document files
Files containing formatting codes and other information that can only be displayed by the application that created
them (document files created in Microsoft Word, for example).

document-centered applications
A type of program design, in which many windows are used to display or edit a document.

double-precision floating point
A data type that requires 8 bytes to store a single variable and that returns values that range from 
-1.79769313486232D308 through 1.79769313486232D308.

drag and drop
Moving an object by clicking it, moving the mouse without releasing the mouse button, and releasing the mouse 
button where you want the object to be.

DragIcon
An object property, which you use to specify a drag icon, which appears while the mouse pointer drags the 
object.

DragMode
An object property, which you use to allow the user to drag an object while the program runs.

DragOver
An event procedure, which Visual Basic executes when the user drags one object over another.

dynamic link library (DLL) files
Executable routines-usually serving a specific function or purpose-that are stored and loaded only when needed 
by the program that calls them.
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Else
A keyword used in multiple-condition If...Then decision structures.

ElseIf



A keyword used in conditional statements in multiple-condition If...Then decision structures.

enabled property
An object property, which turns on a feature or function when the setting is True and turns off a feature or 
function when the setting is False.

End
A program statement that stops the execution of a program in the Visual Basic development environment.

EndDoc
A method that signals the end of a printing job.

EndIf
Keywords used to end a multiple-condition decision structure.

endless loop
A loop test that never evaluates to False. An endless loop executes endlessly and makes the program unable to 
respond to input.

EOF
A keyword that checks for the end of the text file. You use the EOF keyword to load the contents of a text file into
a text box.

error handlers
Special routines designed to respond to runtime errors.

event procedures
Procedures that run when an event (such as a mouse click) occurs.

event-driven programming
A style of programming, in which the program tests for and responds to events generated by the user, such as 
key pressing or mouse clicks. 

executable files
Files containing coded instructions for the operating system.

Exit For
A program statement you use to exit a For...Next loop before the loop has finished executing.

Exit Sub
A program statement you use to exit a Sub procedure.

Exp
A function that returns the constant e raised to the power n.

explicit declaration
Creating a variable by using the Dim (dimension) statement. You declare the variable by typing a Dim statement 
and the variable name.

exponentiation
An advanced operator, which uses the caret (^) symbol to indicate exponentiation (raising a number to a given 
power.)

exposing application features
Making a set of application features available as a collection of objects with their associated properties, 
methods, and events. Automation makes it possible to expose Windows application features to Visual Basic 
programmers.

expression
A combination of symbols (identifiers, variables, and operators) that produce a result when they are evaluated.
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FileCopy
A statement you use to create a backup copy of one or more files from within a Visual Basic program. FileCopy 
makes a separate copy of the file.

filename extension



A set of characters added to a filename that clarifies the content or function of the file. Visual Basic filenames 
use these extensions:
® .vbp      Visual Basic project file
® .frm        Visual Basic form
® .bas      Standard module

filenumber
An object property, an integer from 1 through 255, used to identify a file in your program. When you use 
filename, the file number will be associated with the file whenever you refer to the file in your program code.

FillColor
A Shape control property that specifies the color of a shape.

FillStyle
A Shape control property that specifies the fill pattern.

Font dialog box
The dialog box that appears when you click the Font property in the properties window.

FontSize
The property that specifies the size of text on a form.

For...Next
A type of loop that you can use to execute a specific group of program statements in an event procedure a 
specific number of times.

Form Layout window
A visual design tool, with which you can control the placement of the forms in the Windows environment while 
your program runs.

Form window
The Visual Basic window with which you create the user interface and up interface elements. The Form window 
consists of a default form and a standard grid. 

Frame
A Visual Basic toolbox control, with which you create frames that group objects on a form.

FRM
An object name prefix used in naming form objects, for example, frmMedExpense.

front end
A customized database application that takes the fields and records of a database and displays them in a way 
that is meaningful for a specific group of users. For example, a public library might create a customized version 
of its card catalog for a group of scientific researchers. In addition to customized information, a front end might 
also feature customized database tools, including viewing filters, search commands, print commands, and a 
custom backup tool. With Visual Basic, you can build database front-ends that quickly display just the 
information your users want, and with only the commands they need to process the data.

function
A statement that performs meaningful work and returns a value to the program.

function procedure
A group of statements that actually perform the work that a function is assigned in the program.

function statement
A block of statements that accomplish the work of the function.
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general-purpose procedure
A Sub or Function procedure that performs useful work in your program.    Unlike event procedures, general-
purpose procedures are not tied to elements in the user interface.
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Hide
A method you use to make a form invisible but keep it in memory for use later in the program.

hierarchy
A type of object organization, which branches to smaller and smaller units, each of which is owned by the higher-
level object immediately above it. A hierarchy provides an organizational framework that reflects logical links or 
relationships between its elements. (See also: parent file and child file.)

hourglass
A standard Windows mouse pointer design, which indicates that the user needs to wait.
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I-beam
A standard Windows mouse pointer design used to indicate cursor position in text-based applications.

identifier
A variable or identifier is a special container that holds data temporarily in a program. You create variables to 
store calculation results, create file names, process input, and so on. Variables can store numbers, names, 
property values, and references to objects.

If...Then decision structure
A set of control statements that executes a block of code if a Boolean expression evaluates to True. If...Then 
decision structures can use one or several conditional statements (See also: multiple-condition decision 
structures.)

Image
A Visual Basic control, with which you create objects that can display graphics as bitmaps, icons, or Windows 
metafiles.

image objects
Objects that can display graphics as bitmaps, icons, or Windows metafiles (electronic artwork that you can 
resize.)

Immediate window
A programming tool that helps you debug a program while you are in break mode. When you type a statement in
the Code window, Visual Basic executes it and displays the output in the Immediate window. This quick 
response makes it easier to test the value of specific key variables as your program runs.

implicit declaration
The process of declaring a variable without using the Dim (dimension) statement. To declare a variable implicitly,
you simply use the variable on its own without using the Dim statement.

Index
A Recordset property that you can use to define the database field that will be used in a data search.

Input
A keyword used to indicate the mode (how the file will be used) in the Open statement. Using the Input keyword 
indicates that you want to read the file that you're opening.

input box
A type of data object, with which you gather user input. 

InputBox
A function that prompts the user to supply input in a dialog box.

Int
A function that returns the integer portion of n. For negative numbers, Fix(n) returns a value >= n. (See also: 
Fix(n).)

Integer
A data type that requires 2 bytes to store each variable and that returns values that range from 
-32,768 through 32,767.

integer division
An advanced arithmetic operation, in which the result is an integer (any remainder is discarded.)



invisible controls
Controls that perform special, behind-the-scenes operations in a Visual Basic program and that are not visible to
a user while the program runs.
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keyword
Any one of dozens of words and phrases used to create Visual Basic program statements.

KillDoc
A printer method that terminates the current print job.
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Label
A Visual Basic control, with which you create objects that identify objects on a form (See also: Caption.)

Left measure
The distance of an object to the right of the form's origin (top left-hand corner), measured in twips.

Level Up button
Part of the Open Project dialog box that you click to search files one level higher in the file directory. 

Line control
A toolbox control that helps you specify line width, color, style, and visibility.

Line Input
A keyword that reads a line of input from a text file.

ListBox
A toolbox control you use to create a list box object.

loading a program
Transferring information from storage (such as your hard disk or CD-ROM) into memory. You load information for
processing and program code for execution.

local variable
A variable that can be read or changed only in the procedure that it is declared in.

Locals window
A window in the development environment used in a debugging session to monitor procedure calls.

logic error
An error in reasoning, a programming mistake that makes the program code produce the wrong results.

logical operator
An operator designed to work with Boolean (True and False) values. Logical operators include:
® And
® Or
® Not
® Xor

Long data type
A data type that requires 4 bytes to store each variable and that returns values that range from 
-2,147,483,648 through 2,147,483,647.

Look In drop-down box
Part of the Open Project dialog box that you click to search for files at the current level in the file directory.

loops
A set of statements that a program executes repeatedly.
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Make
A command on the File menu used to create an executable (.exe) file that is capable of running under Windows 
95 or later or Windows NT.

mathematical function
A function in a program that performs a set of mathematical operations and returns a value to the program.

maximizing a form
Resizing a form to its maximum size. 

MDI form
A form that can be organized in a Multiple Document Interface hierarchy.

Members list box
The part of the Visual Basic Object Browser that lists the properties, methods, and events you can view.

menu bar
The Visual Basic programming tool that provides access to most of the commands that control the Visual Basic 
programming environment. You can use these menus and commands by using keyboard commands or the 
mouse. 

Menu Editor command
The Tools menu command, with which you add menus to your programs. 

Menu Editor
A graphical tool, with which you add, modify, reorder, and delete menus in your programs.

method
A special statement that performs an action or service for a particular object.

Microsoft On the Web
A Help menu command with which you open a submenu that provides access to the Internet.

minimizing a form
Resizing a form to its smallest size.

mod
A standard object name prefix used as part of standard module names.

modal form
A type of form that remains open until the user responds to a program prompt.

mode
A state of a program or computer.

module
Special files in your project that contain code and variables that you want to be accessible from all the event 
procedures in your program.

MousePointer
An object property that sets the shape of the mouse pointer. Both standard and custom mouse pointer styles are
available.

Move
The method you use to move individual objects or a collection of objects on a form's coordinate system.

Move First
A method that makes the first record in the Recordset object the current record.

moving windows
Changing the position of windows, the toolbox, or the toolbar in the Visual Basic development environment by 
clicking the title bar and dragging the element to a new location.

MsgBox function
A dialog box function that displays output. MsgBox takes one or more arguments as input. You can assign the 



value returned (the results of the function call) to a variable.

multiple-condition decision structure
A decision structure that contains two or more conditional expressions.
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Name
A property that creates an object name, which distinguishes modules in the program code and in the Project 
window.

nested loop
A loop that is embedded in another loop. In a nested Do loop, for example, the nested (inner) loop executes its 
commands repeatedly until it is finished; then, the other loop continues executing its commands.

New Project
The File menu command you click to open a new Visual Basic project. When you click this command, these 
elements of the Visual basic programming environment appear:
® Menu bar.
® Toolbar.
® Visual Basic toolbox.
® Form window.
® Properties window.
® Project window.
® Immediate window.
® Form Layout window

NewPage
A printer method that starts a new page in a print job.

NoMatch
A Recordset property, which is set to True if no match is found in the search.

nonmodal forms
Forms that the user can switch away from without having to respond to a prompt. (Also known as modeless 
forms.)
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Object Browser
A utility program that you can use to explore the wide variety of objects in Windows-based applications.

object name prefix
Standard, three-letter prefixes that programmers use to identify the type of object the object names. These 
prefixes generally form the first part of the object name. For example, the name cboEnglish applies to a combo 
box that displays information in English.

object 
A type of user interface element you create on a Visual Basic form by using a toolbox control. 

.OCX file
An executable file that remains in storage until a program calls it. Unlike DLL files, however, OCX files inform 
users of the status of a file.

OLE control
A Visual Basic control that creates an OLE (Object Linking and Embedding) object, with which you can transfer 
and share information between applications.

On Error
A program statement used to detect a runtime error. The On Error statement sets an event trap by telling Visual 
Basic where to branch if it encounters an error.



online Help system
The online user assistance system.

Open dialog box
A dialog box that appears when the user clicks the Open command on the File menu. Open is one of the five 
dialog boxes you can create with the Common Dialog object.

Open Project
The File menu command you click to open an existing Visual Basic project.

Open statement
A general-purpose statement used to open files. The Open statement has this syntax:
Open pathname For mode As #filenumber

  
where:

pathname is a valid Windows pathname.
mode is a keyword indicating how the file will be used (Input for reading the file, Output for adding to the file).
filenumber is an integer from 1 through 255, a number that is used to identify the file in program code.

operator precedence
The order in which Visual Basic executes operations in an expression.

operators
In programming, symbols or other characters that indicates an operation that acts on one or more elements. 
Visual Basic uses arithmetic, logical, and Boolean operators.

Output
A keyword used to indicate the mode (how the file will be used) in the Open statement. Using the Output 
keyword indicates that you want to add to the file that you're opening.
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parameter
A value that is being passed into a procedure from another location. You can determine the type of the 
parameter by examining the procedure declaration statement at the top of the procedure.

parent form
In a hierarchical (branching) data structure, a form that is one level higher (closer to the root) than the related 
child form. (See also: child form.) 

pathname
In a hierarchical (branching) filing system, a listing of the directories or folders that lead from the current directory
to a file. 

Picture
An image object property that opens a selected image file.

picture box
A Visual Basic toolbox control, with which you create image objects on a form.

pointer
An onscreen symbol, such as an arrow or I-beam, that is controlled by a mouse or other pointing device.

Print dialog box
One of the five types of dialog boxes you can create with the Common Dialog object.

PrintForm
A method that you can use to send the entire contents of one or more forms to the printer.

program code
The instructions you write using the statements, functions, and special characters of the Visual Basic 
programming language.

program crash
An unexpected event that occurs at runtime that halts execution of a Visual Basic program. (Also known as a 



runtime error.)

program flow
The order in which Visual Basic executes commands in your programs. You control program flow by using 
standard Visual Basic commands in the program code.

program statements
An instruction in program code, the smallest units of executable code in a program. Generally, each line in a 
program is considered an individual statement.

programming tools
The complete set of programming tools that help you construct your Visual Basic programs.

Project Explorer
Another name for the Project window, where you can examine and organize the components of your Visual 
Basic application.

Project window
The part of the Visual Basic development environment that helps you switch back and forth between windows 
and tools as you work on a project.

property
A value or characteristic held by a Visual Basic object, such as Caption or ForeColor. Properties can be set at 
design time by using the Properties window or at runtime by using statements in the program code.

Properties window
The Visual Basic window that you use to change the characteristics (property settings) of the user interface 
elements on a form.    

public variables
Variables that maintain their values throughout all the event procedures of your program.

Public
The keyword you use to create a public variable in a standard module.
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Quick Note
A simple note-taking utility, with which you can take notes and then save them to disk.

Quick Watch
A button on the Debug toolbar, which you can use to watch the content of the program code change as it 
executes, line by line.
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ReadOnly
When set to True, this data object property allows users to view but not modify database information. To allow 
users to make changes to a database, use the Properties window to set the ReadOnly property to False.

Recordset
The part of the database you're currently working with. (A table, for example.) You can adjust the Recordset by 
using the data object's RecordsetType property.

RecordsetType
A Recordset (data object) property, which you can set to:
® 0 for a table 
® 1 for a dynaset
® 2 for a snapshot

RecordSource
A data object property that you use to name the database table that is the source of your data.

remainder division
An advanced mathematical operation, whose result is the remainder of a division operation. For example, 17 



Mod    3 = 2, because the quotient 17/3 has a remainder of 2.

removing files
Removing individual files from a project by using commands on the Project menu. The changes that you make 
will be reflected immediately in the Project window.

resizing windows
Enlarging or shrinking the size of a window by clicking and dragging it along the border. You resize a window to 
make elements of the programming system visible and accessible. 

Restart
A toolbar button and command on the Run menu that runs a program currently in break mode.
Resume 
A keyword used in an error handler, which returns control to the statement that caused the error.

Resume Next
Keywords used in an error handler, which returns control to the program statement following the one that caused
an error.

retry period
A specified period of time, during which a program will try repeatedly to execute a command, and after which, 
the program will continue.

Rnd
A function that generates a random number greater than or equal to 0 and less than 1.

runtime
The time during which a program runs. You can change some Visual Basic properties during runtime. 

runtime error
Any error that forces a program to stop running.

runtime properties
Object properties that you can set while the program runs. You set runtime properties with program code.

runtime values
Variable values that you can set while the program runs. You set runtime values with program code.
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Save As dialog box
One of the five types of dialog boxes you can create by using with the common dialog object. The Save As 
dialog box gets the drive, folder name, and filename for a new file.

Save project
The File menu command that you use to save your current project.

Save Project As
The File menu command that you use to save your current project with a different name, file location, or both.

scope
The extent or range that a variable or procedure holds its value.

scrollable
A user interface element that includes too much information to be visible at once. Such elements include vertical 
or horizontal scroll bars.

Seek
A Recordset (data object) method used to search for a database record. To compare the search string to text in 
the database, use comparison operators.

Select Case
A type of decision structure, in which the results of a test case controls the direction of program flow.

selection criterion
A test made in an If...Then or Select...Case decision structure to locate or filter information.



Sgn
A function that returns a value of:
® -1 if n is less than zero.
® 0 if n is equal to zero.
® +1 if n is greater than zero.

Shape
A toolbox control that helps you define the shape, fill color and style, border color, and visibility of an image. 

shortcut keys
Key combinations that the user can press to run a command without opening a menu.

Show 
A method you can use to display a loaded form. Show method syntax looks like this:

formname.Show mode
  

where 
formname is the name of the form.
mode is:    0 for nonmodal forms (the default).

 1 for modal forms.

Show Next Statement
A command on the Debug menu (available in break mode) that moves the cursor to the line that will execute 
next.

ShowColor
A method used to display the Color dialog box.

ShowFont
A method used to display the Font dialog.

ShowOpen
A method used to display the Open dialog box.

ShowPrinter
A method used to display the Print dialog box.

ShowSave
A method used to display the Save As dialog box

Sin
A function that returns the sine of the angle n. The angle n is expressed in radians.

single-condition decision structures
Decision structures that contain only one conditional statement.

single-precision floating point
A data type that requires 4 bytes to store a single variable and that returns values that range from
-3.042823E38 through 3.402823E38.

sizing pointer
A mouse pointer shape used for sizing objects in a window or form. 

Source
A parameter used in drag-and-drop operations. Source identifies the object that has been dropped or moved 
over. 

splash screen
An introductory or startup graphic, usually the first image you see when you open an application.

Sqr
A function that returns the square root of n.

standard module
A special .bas file that you can open in your project. Standard modules contain the public variables and 



procedures you want to make accessible to all parts of your program.

Step Into
The Debug menu command that helps you isolate program code errors. With the Step Into button on the Debug 
toolbar, you can watch while Visual Basic executes program instructions one at a time.

Stop
A program statement that stops program execution and makes the Code window appear.

Str
A function that converts a number to a numeric string value.

string concatenation
An advanced mathematical operation that joins the contents of two or more strings into a single string by using 
the & operator. Concatenating the strings "Thank you, " and "good night." yields the string "Thank you, good 
night."

Sub procedure
A procedure that:
® Performs useful work in a program.
® Doesn't return a value associated with its name.
® Can return many values.

syntax
The rules of construction that you must use when you build a program statement.

syntax error
A runtime error created by a mistake in the rules of Visual Basic programming.
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tag
A piece of descriptive text stored in the Tag property that can be used to identify the state of a particular object.

Tag property
An object property, with which you create an identification note (tag). Programmers typically use this property to 
identify the object that the program works with in an event procedure. 

Tan
A function that returns the tangent of the angle n. The angle n is expressed in radians.

taskbar
The part of the Windows operating system that you use to switch between Visual Basic forms as your program 
runs and to activate other Windows-based programs. You can find the taskbar along the bottom of the screen.

test case
The key variable, property, or other expression in a decision structure.

testing a program
The process of checking a program against a variety of real-life operating conditions to determine whether it 
works correctly.

TextBox
A Visual Basic control that displays text and receives text as user input.

text files
Files containing unformatted numbers, words, or characters.

timer
A Visual Basic control that serves as an invisible stopwatch. The Timer control gives your time-related programs 
access to the system clock.

toolbar
A collection of buttons that serve as shortcuts for executing commands and controlling the Visual Basic 
development environment.



toolbox controls
Special tools that you use to add user interface elements to a form.

Tools menu
A menu on the Visual Basic menu bar containing commands that let you start the Menu Editor and customize 
your program.

top measure
The distance of an object below the form's origin (upper left-hand corner), measured in twips.

twip
The basic unit of measurement used to indicate an object's position on Visual Basic forms. A twip is 1/20 of a 
printer's point (1/1,440 inch). In the Visual Basic coordinate system, rows of twips are aligned to the x-axis 
(horizontal axis), and columns of twips are aligned to the y-axis (vertical axis). You can define locations in this 
coordinate system by identifying the intersection of a row and a column with the notation (x, y).

type declaration
A symbol or character used to declare (define) a data type in a program.
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Unload
A statement that removes a form from memory and frees up the RAM used to store the objects and graphics on 
the form.

unloading
Removing a program or other information from memory.

Until
A keyword you can use in Do loops to repeat commands until a certain condition is true.

Up Level button
Part of the Open Project dialog box that you click to search for files at higher levels in the file directory.

user interface form
The default form and standard grid that appears when you start Visual Basic.
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Val
A function that converts a numeric string value to a number.

variable
A special container that temporarily holds data in a program. The values that variables return can be numbers, 
names, or properties.

variant
A variable that can hold data of any size or format.

.VBP
The filename extension of a Visual Basic project file.

View Code button
A Project window button that you use to open the Code window and read program code.

View Object button
A Project window button that you use to open a form or other interface object.

Visual Basic development environment
The complete set of programming tools and windows, with which you construct your Visual Basic programs.

Visual Basic for Applications
An enhanced version of Visual Basic designed especially for application macros. For more information about 
Visual Basic for Applications in Microsoft Word, read Microsoft Word 97 Visual Basic Step by Step (Microsoft 
Press), by Michael Halvorson and Chris Kinata.
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.WMF file
A type of resizable graphic image that takes up very little disk space and has a .wmf filename extension.

Watch window
A window in the Visual Basic development environment used to debug applications. You can display the content 
of one or more variables by using the Watch window.
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x, y coordinate system
In the Visual Basic coordinate system, rows of twips are aligned to the x (horizontal) axis, and columns of twips 
are aligned to the y (vertical) axis. To define locations in the coordinate system, you identify the intersection of a 
row and column with the notation (x, y).
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zoom in
To view a smaller part of an image in greater detail. 

zoom out
To view a larger part of an image in less detail.




